
Product description 

The Mentype® NonaplexQS PCR Amplification Kit is a multiplex application for the 
Short Tandem Repeat (STR) loci, which belong to the German Forensic DNA Database 
and are recommended by EDNAP. In one PCR reaction, the eight polymorphic STR loci 
D3S1358, D8S1179, D18S51, D21S11, FGA (FIBRA), SE33 (ACTBP2), 
TH01 (TC11), and vWA as well as the gender-specific Amelogenin are amplified 
simultaneously.  
 
The test kit was developed for fast and reliable DNA genotyping of blood, buccal swabs 
and forensic stains. Moreover, a primer set for SE33 was included that addresses all 
known primer binding site mutations allowing the amplification of those alleles in 
samples containing this variants. The primers are fluorescence-labelled with 6-FAM 
(Amelogenin, D8S1179, D21S11 and D18S51), HEX (TH01, D3S1358 and SE33) or 
NED (vWA and FGA).  
 
As special feature, Mentype® NonaplexQS contains an internal PCR control (Quality 
Sensor “QS”) which provides helpful information on the efficiency of the PCR and on 
the presence of PCR inhibitors. 
 
The detection limit of Mentype® NonaplexQS PCR Amplification Kit is less than 100 pg 
genomic DNA. However, it is recommended to use 0.2-1.0 ng DNA. 
 
The test kit was validated and evaluated using the GeneAmp® 9700 thermal cycler, 
ABI PRISM® 310 Genetic Analyzer, and ABI PRISM® 3100/3130 Genetic Analyzer. 
 
 
Table 1. Locus-specific information of Mentype® NonaplexQS 
Locus GenBank® 

accession 
Repeat motif 
of the reference allele 

Reference 
allele 

Allele 
range 

Amelogenin X M55418    
Amelogenin Y M55419    
D3S1358 11449919 TCTA [TCTG]2 [TCTA]15 18 8-26 
D8S1179 G08710 [TCTA]12 12 6-21.2 
D18S51 L18333 [AGAA]13 13 5.3-42 
D21S11 AP000433 [TCTA]4 [TCTG]6 [TCTA]3 TA [TCTA]3 

TCA [TCTA]2 TCCATA [TCTA]11 

29 12-46 

FGA (FIBRA) M64982 [TTTC]3 TTTTTTCT [CTTT]13 CTCC 
[TTCC]2 

21 12.2-51.2 

SE33 (ACTBP2) NG000840 [AAAG]9 AA [AAAG]16 25.2 3-50 
TH01 (TC11) D00269 [TCAT]9 9 3-14 
vWA M25858 TCTA [TCTG]4 [TCTA]13  18 10-26 
 
Table 1 shows the STR loci with their repeat motifs and alleles that are concordant with 
the International Society for Forensic Genetics (ISFG) guidelines for the use of 
microsatellite markers (Bär et al., 1997). Allele ranges include all known alleles of the 
National Institute of Standards and Technology (NIST as at 12/2008) and of the current 
literature. 
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Table 2. Chromosomal mapping of Mentype® NonaplexQS 

Locus Chromosomal mapping   
Amelogenin X Xp22.1-22.3   
Amelogenin Y Yp11.2   
D3S1358 3p25.3   
D8S1179 8q23.1-23.2   
D18S51 18q21.3   
D21S11 21q21.1   
FGA (FIBRA) 4q28.2   
SE33 6q14.2   
TH01 11p15.5pter   
vWA 12p13.31   
 
 
Content 

Mentype® NonaplexQS PCR Amplification Kit (100 Reactions) 
Nuclease-free water 3.0 mL 
Reaction mix A 500 μL 
Primer mix 250 μL 
DNA polymerase 40 μL 
Control DNA XY1 (2 ng/μL) 10 μL 
DNA Size Standard 550 (ROX) 50 μL 
Allelic ladder*  10 μL 

* Since January 2008 the allelic ladder Mentype® NonaplexQS extended (Cat. No. 48-09330-0010) is 
additionally available (see page 27). 
 
 
Ordering information  
Mentype® NonaplexQS 100 reactions Cat. No. 41-09330-0100 
Mentype® NonaplexQS 400 reactions Cat. No. 41-09330-0400 
Mentype® NonaplexQS 1000 reactions Cat. No. 41-09330-1000 

 
 
Storage 

Store all components at –20°C and avoid repeated thawing and freezing. Primer mix 
and allelic ladder must be stored protected from light. The DNA samples and post-PCR 
reagents (allelic ladder and DNA size standard) should be stored separately from the 
PCR reagents. The expiry date is indicated on the kit cover.  
 
 
Quality assurance 
All kit components undergo an intensive quality assurance process at Biotype 
Diagnostic GmbH. The quality of the test kits is permanently monitored in order to 
ensure unrestricted usability. Please contact us if you have any questions regarding 
quality assurance. 
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Additionally required reagents 

Additional reagents are needed in order to use the Biotype® PCR Amplification Kit: 
Reagent Supplier Order number 
Hi-Di™ Formamide, 25 mL Applied Biosystems 4311320 
Matrix Standards DS-30 
for ABI PRISM® 310 Genetic Analyzer Applied Biosystems 401546 and 402996 (NED) 

Matrix Standards DS-30 
for ABI PRISM® multi-capillary instruments Applied Biosystems 4345827 

 
 
Trademarks and patents 

Mentype® is a registered trademark of Biotype Diagnostic GmbH. 
ABI PRISM®, GeneScan®, Genotyper®, GeneMapper™ and Applied Biosystems are 
registered trademarks of Applied Biosystems Inc. or its subsidiaries in the U.S. and 
certain other countries. 
6-FAM, HEX, NED, ROX, POP-4 and Hi-Di are trademarks of Applied Biosystems Inc. 
GeneAmp® is a registered trademark of Roche Molecular Systems. 
The PCR is covered by patents. Patentees are Hoffmann-La Roche Inc. and 
F. Hoffmann-La Roche (Roche). 
GenBank® is a trademark of National Institute of Health. 
 
NOTICE TO PURCHASER: LIMITED LICENSE 
 
This product is sold under licensing arrangements between Licensee and Life Technologies Corporation. The 
purchase price of this product includes limited, nontransferable rights under certain U.S. and foreign patent(s) 
owned by Life Technologies Corporation to use only this amount of the product to practice the claims in said 
patents solely for activities of the purchaser in the field of human or animal identification. No other rights are 
conveyed. Further information on purchasing licenses under the above patents may be obtained by contacting 
the Licensing Department, Life Technologies Corporation, 5791 Van Allen Way, Carlsbad, California 92008. 
Email: outlicensing@lifetech.com. 

 

Warnings and safety instructions 
The PCR Amplification Kit contains the following potentially hazardous chemicals:  
Kit component Chemical Hazards 
Primer mix, reaction mix 
and allelic ladder 

Sodium azide NaN3 toxic if swallowed, develops toxic gases 
when it gets in contact with acids  

Observe the Material Safety Data Sheets (MSDS) for all Biotype® products, which are 
available on request. Please contact the respective manufacturers for copies of the 
MSDS for any additionally needed reagents. 
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1. PCR amplification 

1.1 Master mix preparation 

The table below shows the volumes of all PCR reagents per 25 μL reaction volume, 
including a sample volume of 1.0 μL (template DNA). The number of reactions to be 
set up shall be determined taking into account positive and negative control reactions. 
Add one or two reactions to this number to compensate the pipetting error. 
 
Component Volume 
Nuklease-free water 16.1 μL 
Reaction mix A* 5.0 μL 
Primer mix 2.5 μL 
Multi Taq2 DNA Polymerase (hot start, 2.5 U/μL) 0.4 μL 
Volume of master mix 24.0 μL 

* contains Mg2+, dNTPs, BSA 
 
All components should be mixed (vortex) and centrifuged for about 10 s before 
preparing the master mix. The DNA volume applied to the assay depends on its 
concentration. A volume of up to 5 μL may be necessary for DNA trace templates. DNA 
volumes of more than 5 μL are not recommended, because potential PCR inhibitors 
may interfere with the process. Fill up the final reaction volume to 25 μL with 
nuclease-free water. 
 
Generally, DNA templates shall be stored in nuclease-free water or in diluted TE buffer 
(10 mM Tris HCl, pH 8.0 and 1 mM EDTA), e.g. 0.1x TE buffer. 
 
The primer mixes are adjusted for balanced peak heights at 30 PCR cycles and 
0.35 ng Control DNA XY1 in a reaction volume of 25 μL. If more DNA template is 
introduced, higher peaks can be expected for small PCR fragments and relatively low 
peaks for large fragments. Reduce the amount of DNA template to correct this 
imbalance. 
 
 
Positive control 
For the positive amplification control, dilute the Control DNA XY1 to 0.35 ng in the 
appropriate volume. Instead of the template DNA pipette the diluted Control DNA into a 
reaction tube containing the PCR master mix. 
 
Negative control 

For the negative amplification control, pipette nuclease-free water instead of template 
DNA into a reaction tube containing the PCR master mix. 
 

Protocols for PCR amplification, electrophoresis and analysis 
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1.2 PCR amplification parameter 

Perform a “hot start” PCR in order to activate the Multi Taq2 DNA Polymerase and to 
prevent the formation of non-specific amplification products. 
 
The number of cycles depends on the amount of DNA. 30 cycles are recommended for 
all samples. For critical stains (< 100 pg DNA), it is recommended to increase the 
number of PCR cycles from 30 to 34. 
 

Standard method 
Recommended for all DNA samples  
Temperature Time 
94°C 4 min (hot start for activation of the Multi Taq2 DNA Polymerase) 
94°C 30 s 
60°C 120 s 
72°C 75 s 

30 cycles 

68°C 60 min  
10°C ∞ hold 
 

Optional 
Recommended for stains with small amounts of DNA 
Temperature Time 
94°C 4 min (hot start for activation of the Multi Taq2 DNA Polymerase) 
94°C 30 s 
60°C 120 s 
72°C 75 s 

34 cycles 

68°C 60 min  
10°C ∞ hold 
 
 
Too small amounts of DNA may result in allelic dropouts and imbalances of the peaks. 
Furthermore, unspecific amplification products could appear. With increasing numbers 
of cycles, there is the risk of cross contamination caused by minimal amounts of 
impurities. 
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2. Electrophoresis using the ABI PRISM® 310 Genetic Analyzer 

For general instructions on instrument setup, matrix generation and application of the 
GeneScan® or GeneMapper™ ID software, refer to the ABI PRISM ® 310 Genetic 
Analyzer User’s Manual. Electrophoresis using the GeneScan® software is described 
below.  
 
The virtual filter set D shall be used for combined application of the four fluorescent 
labels 6-FAM, HEX, NED, and ROX (also called DS-30). Generally, Filter Sets A and F 
are suitable, too.  
 
Material  
Capillary 47 cm / 50 μm (green) 
Polymer POP-4 for 310 Genetic Analyzer  
Buffer 10x Genetic Analyzer Buffer with EDTA 
 
 

2.1 Matrix generation 
Prior to conducting DNA fragment size analysis with the filter set D, a matrix with the 
four fluorescent labels 6-FAM, HEX, NED, and ROX must be generated. The suitable 
matrix standard DS-30 is available from Applied Biosystems. 
 
Colour Matrix standard Order number 
Blue (B) 6-FAM Applied Biosystems, 401546 
Green (G) HEX Applied Biosystems, 401546 
Yellow (Y) NED Applied Biosystems, 402996 
Red (R) ROX Applied Biosystems, 401546 
 
Four electrophoresis runs shall be conducted, one for each fluorescent label, 6-FAM, 
HEX, NED, and ROX, under the same conditions as for the samples and allelic ladders 
of the Biotype® test kit to generate suitable matrix files. 
 
Matrix sample Component Volume 

Hi-Di™ Formamide 12.0 μL 
Matrix sample 1 

Matrix standard 6-FAM 1.0 μL 
   

Hi-Di™ Formamide 12.0 μL 
Matrix sample 2 Matrix standard HEX 1.0 μL 
   

Hi-Di™ Formamide 12.0 μL 
Matrix sample 3 

Matrix standard NED 1.0 μL 
   

Hi-Di™ Formamide 12.0 μL 
Matrix sample 4 

Matrix standard ROX 1.0 μL 
- Denaturation for 3 min at 95°C 
- Cool down to 4°C 
- For analysis: load the samples on the tray 
 
- Create a Sample Sheet and enter sample designation 
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Injection list for matrix generation 
Parameter Set up 
Module File GS STR POP-4 (1 mL) D 
Matrix File NONE 
Size Standard* NONE 
Injection [s] 5 
Injection [kV] 15.0 
Run [kV] 15.0 
Run [°C] 60 
Run Time [min] 24 

* prepare matrix standards always without DNA Size Standard (ROX)  
 
Analysis of the matrix samples 
- Run the GeneScan® software 
- File → New → Project (open folder of current run) → Add Sample Files 
- Select a matrix sample in the Sample File column  
- Sample → Raw Data 
- Check the matrix samples regarding a flat baseline. As shown in the figure below, 

there should be at least five peaks with peak heights about 1000-4000 (Y-axis) for 
each matrix sample (optimal range: 2000-4000) 

 

 
Fig. 1 Electropherogram with raw data of the matrix standard 6-FAM 
 
- Select analysis range with flat baseline and re-inject the matrix sample if necessary 
- Note down start and end value (data points) of the analysis range, e.g.  
   start value 3400, end value 6400 
- Calculate the difference, e.g. 6400-3400 = 3000 data points 

 ▼ 3400 Data Points (X) 
 

 6400▼ 
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Generation of a new matrix 

- File → New → Matrix 

 
Fig. 2 Matrix sample selection 

 
- Import matrix samples for all dyes (B, G, Y, R) 
- Enter a Start At value, e.g. 3400 
- Enter the calculated difference under Points, e.g. 3000 
- Click on OK to calculate the new matrix 
 

 
Fig. 3 New matrix DS-30  
 
- Save the matrix in the matrix folder: File → Save as, e.g. Matrix DS-30 
 
 
Matrix check 

Check the new matrix with current samples. 
- File → New → Project (open folder of the respective run) → Add Sample Files 
- Select sample(s) in the Sample File column  
- Sample → Install New Matrix (open matrix folder and select new matrix) 
- Re-analyse your samples 
 
There should be no pull-up peaks between the dye panels (B, G, Y, R) with the new 
matrix. 
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2.2 Sample preparation 
Component Volume 
Hi-Di™ Formamide 12.0 μL 
DNA Size Standard 550 (ROX) 0.5 μL 
prepare 12 μL of the mix (formamide + DNA size standard) for all samples  
add 1 μL PCR product (diluted if necessary) or allelic ladder  
- Denaturation for 3 min at 95°C  
- Cool down to 4°C  
- For analysis: load the samples on the tray  
 
 
Signal intensities 

Options to increase the signal intensity: 
- Reduce the volume of the DNA Size Standard 550 (ROX) to peak heights of  

about 500 relative fluorescent units (RFU)  
- Purify the PCR products before starting the analysis  
 
 

2.3 Setting up the GeneScan® software 

- Create a Sample Sheet and enter sample designation 
 
Injection list 
Parameter Set up 
Module File GS STR POP-4 (1 mL) D 
Matrix File e.g. Matrix DS-30 
Size Standard e.g. SST-ROX_50-450bp 
Injection [s]* 5 
Injection [kV] 15.0 
Run [kV] 15.0 
Run [°C] 60 
Run Time [min]** 26 

* Deviating from standard settings, the injection time may range between 1 and 10 s depending on the type of 
sample. If blood samples with very high signal intensities are recorded, a shorter injection time may be selected. 
For samples with low DNA content an injection time up to 10 s may be necessary.  

 
** Depending on the analysis conditions the run time for Mentype® NonaplexQS was modified in order to 
analyse fragments with lengths of up to 450 bp. 
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2.4 Analysis parameter 

The recommended analysis parameters are: 
 
Analysis Range Start: 2000 

Stop: 10000 
Data Processing Baseline: Checked 

Multicomponent: Checked 
Smooth Options: Light 

Peak Detection Peak Amplitude Thresholds 
B:*    Y:* 
G:*    R:* 
Min. Peak Half Width: 2 pts 
Polynorminal Degree: 3 
Peak Window Size: 11 pts** 

Size Call Range Min: 50 
Max: 550 

Size Calling Method Local Southern Method 
Split Peak Correction None 

 

* The peak amplitude threshold (cutoff value) corresponds to the minimum peak height that will be detected by 
the GeneScan® or GeneMapper™ ID software. Thresholds are usually 50-200 RFU and should be determined 
individually by the laboratory. Recommendation: The minimal peak height should be three times as high as the 
background noise of the baseline. 

 
** Point alleles (i.e. alleles with at least 1 bp difference to the next integer allele) may occasionally not be 
distinguished. For improved peak detection, minimise the Peak Window Size further. 
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3. Electrophoresis using the ABI PRISM® 3130/3130xl Genetic Analyzer 

For detailed instructions on instrument setup, spectral calibration, or application of the 
ABI PRISM® Data Collection software version 3.0 and the GeneMapper™ ID software, 
refer to the ABI PRISM ® 3130/3130xl Genetic Analyzers Getting Started Guide.  
 
The system with 4 capillaries is named ABI 3130 (former ABI 3100-Avant), and the 
system with 16 capillaries is named ABI 3130xl (former ABI 3100).  
 
The virtual filter set D shall be used for combined application of the four fluorescent 
labels 6-FAM, HEX, NED, and ROX (also called DS-30). 
 
Material  
Capillary 36 cm Capillary Array for 3130/3130xl 
Polymer POP-4 Polymer for 3130 
Buffer 10x Genetic Analyzer Buffer with EDTA 
 
 

3.1 Spectral calibration / matrix generation 

Prior to conducting DNA fragment size analysis, it is necessary to perform a spectral 
calibration with the four fluorescent labels 6-FAM, HEX, NED, and ROX for each 
analyzer. The calibration procedure creates a matrix which is used to correct the 
overlapping of fluorescence emission spectra of the dyes.  
 
Spectral calibration comprises the following steps: 
- Preparation the spectral calibration standards 
- Loading the standards to the 96-well reaction plate (one sample per capillary) 
- Creating the instrument protocol for spectral calibration (Protocol Manager) 
- Defining the plate composition in the plate editor (Plate Manager) 
- Performing a spectral calibration run and checking the matrix 
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Setting up the spectral calibration standards 

Example for 4 capillaries/ABI 3130 
Component Volume 
Hi-Di™ Formamide 47.5 μL 
Matrix standard DS-30 2.5 μL 
- Load 12 μL of the mix to a 96-well reaction plate, e.g. position A1-D1 
- Denaturation for 3 min at 95°C 
- Cool down to 4°C 
 
 
Example for 16 capillaries/ABI 3130xl 
Component Volume 
Hi-Di™ Formamide 190.0 μL 
Matrix standard DS-30 10.0 μL 
- Load 12 μL of the mix to a 96-well reaction plate, e.g. position A1-H1 and A2-H2 
- Denaturation for 3 min at 95°C 
- Cool down to 4°C 
 
 
Performing a spectral calibration run 

- Place the 96-well plate on the autosampler tray 
- In the Protocol Manager of the Data Collection software click New the window 

Instrument Protocol to open the Protocol Editor dialog box 
 
 
Instrument Protocol for spectral calibration 
Protocol Editor Set up 
Name User (e.g. Spectral36_POP4_DS30) 
Type SPECTRAL 
Dye Set D 
Polymer* User (e.g. POP4) 
Array Length* User (e.g. 36cm) 
Chemistry Matrix Standard 
Run Module* Default (e.g. Spect36_POP4_1) 

* Depends on the type of polymer and length of capillary used 
 
- Select OK to complete the Protocol Editor dialog box 
- In the Plate Manager of the Data Collection software click New to open the New 

Plate Dialog box 
 
Plate Editor for spectral calibration (I) 
New Plate Dialog Set up 
Name e.g. Spectral_DS-30_date 
Application Spectral Calibration 
Plate Type 96-Well 
Owner Name / Operator Name … 
 
- Click on OK. A new table in the Plate Editor opens automatically 
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Plate Editor for spectral calibration (II) 
Parameter  Set up 
Sample Name Type name for the matrix samples 
Priority  e.g. 100  
Instrument Protocol 1 Spectral36_POP4_DS30 (setting described before) 
 
- Click into the column header to select the entire column, select Edit → Fill Down to 

apply the information to all selected samples, and click on OK 
- In the Run Scheduler click on Find All, select Link to link the reaction plate on the 

autosampler up with the newly created plate record (position A or B) and start the run 
 

 
Fig. 4 Electropherogram of spectral calibration with matrix standard DS-30 on an ABI 3130 
 
 
Matrix check 

- The quality value (Q value) of each capillary must be greater than 0.95 and the  
   condition number range (C value) must be between 1 and 20. 
- Check the matrix samples for a flat baseline. As shown in the figure above, there 

should be four peaks with peak heights of about 1000-5000 (Y-axis) in each matrix 
sample (optimal range: 2000-4000) 

- Check the new matrix with your current samples. There should be no pull-up peaks 
between the dye panels (B, G, Y, R) with the new matrix 

- If calibration was not successful, use the optimised values and repeat the calibration 
run 

- If all capillaries have passed the test, the last calibration file for the Dye Set D is 
activated automatically in the Spectral Viewer. Rename the calibration file (e.g. 
DS-30_Date of calibration) using the respective button 

        R, Y,   G,     B 
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3.2 Sample preparation 
Component Volume 
Hi-Di™ Formamide 12.0 μL 
DNA Size Standard 550 (ROX)   0.5 μL 
prepare 12 μL of the mix (formamide + DNA size standard) for all samples 
add 1 μL PCR product (diluted if necessary) or allelic ladder 
- Denaturation for 3 min at 95°C  
- Cool down to 4°C  
- For analysis: load the samples on the tray  
 
Since injections take place simultaneously on all capillaries, 4 or 16 samples must be 
pipetted on the plate of multi-capillary analysers. If fewer samples are analysed, the 
empty positions must be filled with 12 μL Hi-Di™ Formamide. 
 
To ensure a reliable allelic assignment on multi-capillary analysers, several ladders 
should be run. 
 
Room temperature may influence the performance of PCR products on multi-capillary 
instruments, so that shoulder peaks or split peaks occur especially at low 
temperatures. Pay attention to keeping ambient conditions as recommended by the 
instrument manufacturer. 
 
 
Signal intensities 

Options to increase the signal intensity: 
- Reduce the volume of the DNA Size Standard 550 (ROX) to peak heights of about 

500 relative fluorescent units (RFU)  
- Purify the PCR products before starting the analysis  
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3.3 Setting up the GeneMapper™ ID software 

Edit the Run Module as follows for the first run: 
- In the Module Manager of the Data Collection software click on New to open the 

Run Module Editor dialog box 
 
Run Module 3kV_10s_450bp 
Parameter Set up 
Oven Temperature [°C] Default 
Poly Fill Volume Default 
Current Stability [μA] Default 
PreRun Voltage [kV] Default 
PreRun Time [s] Default 
Injection Voltage [kV] 3.0 
Injection Time [s]* 10 
Voltage Number of Steps Default 
Voltage Step Interval Default 
Data Delay Time [s] Default 
Run Voltage [kV] Default 
Run Time [s]** 1320 

* Deviating from the standard settings, the injection time may range between 1 and 20 s depending on the type 
of sample. If samples with very high signal intensities are recorded, a shorter injection time may be selected. 
For samples with low DNA content an injection time of up to 20 s may be necessary.  
 
** Depending on the analysis conditions the run time for Mentype® NonaplexQS was modified in order to be 
able to analyse fragments with lengths of up to 450 bp. 

 

- Click on Save As, enter the name of the new module (e.g. 3kV_10s_450bp) and confirm 
with OK 

- Click on Close to exit the Run Module Editor 
 
 
Starting the run 

- Place the prepared 96-well plate on the autosampler tray 
- In the Protocol Manager of the Data Collection software, click on New in the 

Instrument Protocol window to open the Protocol Editor dialog box 
 

Instrument Protocol 
Protocol Editor Set up 
Name e.g. Run36_POP4_DS-30_22min 
Type REGULAR 
Run Module* 3kV_10s_450bp 
Dye Set D 

* parameter see above 
 
- Click on OK to exit the Protocol Editor 
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Prior to each run, it is necessary to create a plate definition as follows: 
- In the Plate Manager of the Data Collection software click on New to open the New 

Plate Dialog box 
 
GeneMapper™ Plate Editor (I) 
New Plate Dialog Set up 
Name e.g. Plate_DS-30_Date 
Application select GeneMapper Application 
Plate Type 96-Well 
Owner Name / Operator Name … 
 
- Click OK. A new table in the Pate Editor opens automatically 
 
GeneMapper™ Plate Editor (II) 
Parameter Set up 
Sample Name Type name for the samples 
Priority  e.g. 100 (Default) 
Sample Type Sample or Allelic Ladder 
Size Standard e.g. SST-ROX_50-450bp 
Panel e.g. Biotype_Panels_ v3a (choose test kit) 
Analysis Method e.g. Analysis_HID_3130 
Snp Set - 
User-defined 1-3 - 
Results Group 1 (select results group) 
Instrument Protocol 1 Run36_POP4_DS-30 (setting described earlier) 
 
- Click into the column header to select the entire column, select Edit → Fill Down to 

apply the information to all selected samples and click on OK 
- In the Run Scheduler, click on Find All, select Link to link the reaction plate on the 

autosampler up with the newly created plate record (position A or B) and start the run  
- During the run, view Error Status in the Event Log or examine the quality of the raw 

data for each capillary in the Capillaries Viewer or the Cap/Array Viewer 
- View data as overview in Run History or Cap/Array Viewer of the Data Collection 

software. Run data are saved in the Run Folder of the previously chosen Result 
Group 
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3.4 Analysis parameter / analysis method 

The recommended settings in the worksheet Peak Detector are: 
 
Peak Detection Algorithm Advanced 
Ranges Analysis: Partial Range 

Start Pt: 2000; Stop Pt: 10000 
Sizing: All Sizes 

Smoothing and Baselining Smoothing: Light  
Baseline Window: 51 pts 

Size Calling Method Local Southern Method 
Peak Detection Peak Amplitude Thresholds 

B:*    Y:* 
G:*    R:* 
Min. Peak Half Width: 2 pts 
Polynominal Degree: 3 
Peak Window Size: 11 pts** 
Slope Thresholds: 0.0 

* The peak amplitude threshold (cutoff value) corresponds to the minimum peak height that will be detected by 
the GeneMapper™ ID software. The thresholds are usually 50-200 RFU and should be determined individually 
by the laboratory. Recommendation: The minimal peak height should be three times as high as the background 
noise of the baseline. 
 
** Point alleles (i.e. alleles with at least 1 bp difference to the next integer allele) may occasionally not be 
distinguished. For improved peak detection, minimise the Peak Window Size further. 
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4. Analysis 

For general instructions on automatic sample analysing, refer to the GeneScan® or 
GeneMapper™ ID Software User’s Manual.   
 
Finding the exact lengths of the amplified products depends on the device type, the 
conditions of electrophoresis, as well as the DNA size standard used. Due to the 
complexity of some loci, determining the size should be based on evenly distributed 
references. The DNA Size Standard 550 (ROX) shall thus be used with the following 
lengths of fragments: 50, 60, 70, 80, 90, 100, 120, 140, 160, 180, 190, 200, 220, 
240, 260, 280, 300, 320, 340, 360, 380, 400, 425, 450, 475, 500, 525, and 550 
bp.  
 

 
Fig. 5 Electropherogram of the DNA Size Standard 550 (ROX), fragments with lengths in bp 

 
Note: The basic template files for the DNA Size Standard 550 (ROX) has to be adjusted 
to 450 bp within the GeneMapper™ ID software. The new template could be saved as 
e.g. SST-ROX_50-450bp and used for further analyses.  
 
 
As mentioned before, Mentype® NonaplexQS contains an internal PCR control 
(Quality Sensor), which provides helpful information on the efficiency of the PCR and on 
presence of PCR inhibitors. A 6-FAM labelled 72 bp-fragment is amplified 
independently of the DNA. The PCR control assay without DNA shows only the sensor 
fragment (Fig. 6) and indicates successful polymerase chain reaction.  
 

 
Fig. 6 Electropherogram of the 6-FAM labelled PCR control fragment (Quality Sensor). Fragment length in bp, 
signal intensities in peak height 
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4.1 Biotype® template files 

Allele allocation should be carried out with a suitable analysis software, e.g. 
GeneMapper™ ID or Genotyper® software in combination with the Mentype®  
NonaplexQS template files from Biotype. Template files are available from our 
homepage or as CD-ROM on request.  
 

Recommended Biotype® templates for GeneMapper™ ID/ID-X software are: 
Panels Biotype_Panels_v3a/v3X (choose kit) or higher versions 
BinSets Biotype_Bins_v3a/v3X or higher versions 
Size Standard SST-ROX_50-500bp (adjust up to 450bp, adjustment described earlier) 
Analysis Method Analysis_HID_310  
 Analysis_HID_3130  
 Analysis_HID_310_50rfu  
 Analysis_HID_3130_50rfu  
Plot Settings Plots_4dyes  
Table Settings Table for 2 alleles   
 Table for 10 alleles  
 
Panels and BinSets always have to be used whereas the other template files are 
optional.  
 

Additional Biotype® templates for GeneMapper™ ID-X Software: 
Stutter* Biotype_Stutter_v3X or higher version 

* When loading the above mentioned panels, the stutter settings will not be accepted. Thus, the stutter data has 
to be imported separately.  
 

Recommended Biotype® template files for Genotyper® software are: 
for standard allelic ladder Nonaplex-QS_v1d or higher versions 
for extended allelic ladder Nonaplex_QS-EXT_v0 or higher versions 
 
 

General procedure for the analysis 

1. Check the DNA size standard 
2. Check the allelic ladder 
3. Check the positive control 
4. Check the negative control 
5. Analyse and interpret the sample data 
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4.2 Controls 

The Control DNA XY1 of the test kit and other commercially available DNA from 
standard cell lines represent the following alleles: 
 
Table 3. Allele assignment of Mentype® NonaplexQS 

Locus Control  
DNA XY1 

ATCC  
K-562 

CCR 
9947A 

CCR 
9948 

CCR 
3657 

Amelogenin X / Y X / X X / X X / Y X / Y 
D3S1358 17 / 18 16 / 16 14 / 15 15 / 17 16 / 18 
D8S1179 9 / 10 12 / 12 13 / 13 12 / 13 15 / 16 
D18S51 12 / 14 15 / 16 15 / 19 15 / 18 12 / 20 
D21S11 27 / 28 29 / 30 / 31 30 / 30 29 / 30 28 / 29 
FGA 20 / 26 21 / 24 23 / 24 24 / 26 18 / 23 
SE33 17 / 21.2 26.2 / 28.2 19 / 29.2 23.2 / 26.2 22.2 / 27.2 
THO1 6 / 9.3 9.3 / 9.3 8 / 9.3 6 / 9.3 7 / 9.3 
vWA 15 / 18 16 / 16 17 / 18 17 / 17 14 / 19 
 
For further confirmation, the table above displays the alleles of the reference DNA      
purchased from ATCC (http://atcc.org/Produtcs/PurifiedDNA.cfm#celllines) as well as 
three reference DNA purchased from Coriell Cell Repositories (CCR; 
http://locus.umdnj.edu/nigms/) that is up to standard of Szibor et al. (2003). 
 
 

4.3 Lengths of fragments and alleles 

Table 4 to table 9 show the fragment lengths of individual alleles that refer to the 
DNA Size Standard 550 (ROX). All analyses have been performed on an 
ABI PRISM® 310/3130 Genetic Analyzer with POP-4 polymer. Different analysis 
instruments, DNA size standards or polymers may result in different fragment lengths.  
In addition, a visual alignment with the allelic ladder is recommended. 
 

Scaling 

Horizontal: 75-455 bp (with Quality Sensor 65-455 bp) 
Vertical:  Depending on signal intensity 
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Figure 7 
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Fig. 7 Electropherogram of the Mentype® NonaplexQS using 500 pg Control DNA XY1. The Quality Sensor (QS) is 
shown at 72 bp. Analysis was performed on an ABI PRISM® 310 Genetic Analyzer with the DNA Size Standard 550 
(ROX). Allele assignment was performed using the Genotyper® software and the Mentype® NonaplexQS template file. 
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Figure 8 

Fig. 8 Electropherogram of the allelic ladder Mentype® NonaplexQS analysed on an ABI PRISM® 310 Genetic Analyzer. 
Allele assignment was performed using the Genotyper® software and the Mentype® NonaplexQS template files. 
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Table 4. Fragment lengths of the allelic ladder Mentype® NonaplexQS analysed on an  
ABI PRISM® 310/3130 Genetic Analyzer (blue panel) 
 
Marker/allele Size [bp]* Further 

alleles** 
Marker/allele Size [bp]* Further 

alleles** 
Marker/allele Size [bp]* Further 

alleles** 

PCR control 6-FAM  D21S11 6-FAM  D18S51 6-FAM  

Quality 
Sensor 

72  24.2 181 23.2, 24 8 288 7 

   25 183 25.2 9 292 9.2 

Amelogenin 6-FAM  26 188 26.2 10 296 10.2 

X 83  27 192  11 300 11.2 

Y 86  28 196 28.2, 28.3 12 304 12.2 

   29 200  13 308 13.2 

D8S1179 6-FAM  29.2 202 29.3 14 312 14.2 

7 101  30 204 30.2 15 316  

8 106  31 208  16 320 16.2 

9 110  31.2 210  17 325 17.2, 17.3 

10 114  32 212  18 329  

11 118  32.2 214  18.2 331  

12 123  33 216 33.1 19 333 19.2 

13 127  33.2 218  20 337  

14 131  34 220 34.1 21 341 21.2 

15 135  34.2 222 35, 35.2 22 345  

16 140  36 228  23 349 23.1 

17 144  36.2 230  24 353  

18 148  37 232 37.2, 38, 
38.2, 39 

25 357 26, 27, 28, 
29 

19 152 20       
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Table 5. Fragment lengths of the allelic ladder Mentype® NonaplexQS analysed on an  
ABI PRISM® 310/3130 Genetic Analyzer (green panel) 
 
Marker/allele Size [bp]* Further 

alleles** 
Marker/allele Size [bp]* Further 

alleles** 
Marker/allele Size [bp]* Further 

alleles** 

TH01 HEX  SE33 HEX  SE33 HEX  

4 88 3 6.3 207 4.2, 5.3 24.2 276 24 

5 92  7.3 211 7 25 278  

6 96 6.3 8 212 8.2 25.2 280  

7 100 7.3 9 216 9.2 26.2 284 26 

8 104 8.3 10 219  27.2‡ 288 27 

9 108 9.1 10.2 221  28.2 291 28, 28.3 

9.3 111  11 223 11.2 29.2 295 29 

10 112  12 227 12.2 30.2 299 30 

10.3 116 11 13 231  31.2 303 31 

13 125  13.2 233 13.3 32 305  

13.3 128  14 235 14.2, 14.3 32.2 307  

   15 239  33 309  

D3S1358 HEX  15.2 241  33.2 311  

10 149 8, 9 16‡ 243 16.2, 16.3 34 313 34.2 

11 153  17 247 17.2, 17.3 35 317 35.2 

12 157  18 251  36 321 36.2 

13 161  18.2 253 18.3 37 325 37.2 

14 165  19 255  38 329 39, 42 

15 169  19.2 257  49 372  

16 173  20 259 20.1    

17 178  20.2 261     

18 182  21 263     

19 186  21.2 265     

20 190 21 22.2 269 22    

   23.2 272 23    

         

‡ For a better orientation, these alleles are heightened within the allelic ladder 
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Table 6. Fragment lengths of the allelic ladder Mentype® NonaplexQS analysed on an  
ABI PRISM® 310/3130 Genetic Analyzer (yellow panel) 
 

Marker/allele Size [bp]* Further alleles** Marker/allele Size [bp]* Further alleles** 

vWA NED  FGA NED  

11 108 10 14 182 15 

12 113  16 191 16.1 

13 117  17 195  

14 122  18 199 18.2 

15 126  19 203 19.2 

16 130  20 207 20.2 

17 134  21 211 21.2 

18 138  22 215 22.2 

19 142  23 219  

20 146  23.2 221 23.3 

21 150  24 223 24.1, 24.2 

22 154 23, 24 25 227 25.2 

   26 231 26.2 

   27 235  

   28 240  

   29 244  

  
 30 248 30.2, 31, 31.2, 32.2, 33, 

33.2, 34, 37.2 

   42.2 299 43.2, 44.2, 45.2, 46.2, 47.2, 
48.2, 50.2, 51.2 

      

* rounded to integer 

** The “off-ladder” alleles of Biotype’s DNA pool are allocated with the actual Biotype® template files for GeneMapper™ ID 
or Genotyper® software. For further alleles see amongst others http://www.cstl.nist.gov/biotech/strbase/str_fact.htm  
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Figure 9 

Since January 2008 the allelic ladder Mentype® NonaplexQS extended (Cat. No. 48-09330-0010) 
is additionally available. 

 

Fig. 9 Electropherogram of the allelic ladder Mentype® NonaplexQS extended analysed on an ABI PRISM® 310 Genetic Analyzer. 
Allele assignment was performed using the Genotyper® software and the Mentype® NonaplexQS extended template files. 
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Table 7. Fragment lengths of the allelic ladder Mentype® NonaplexQS extended analysed  
on an ABI PRISM® 310/3130 Genetic Analyzer (blue panel) 
 
Marker/allele Size [bp]* Further 

alleles** 
Marker/allele Size [bp]* Further 

alleles** 
Marker/allele Size [bp]* Further 

alleles** 

PCR control 6-FAM  D21S11 6-FAM  D18S51 6-FAM  

Quality Sensor 72  24.2 181 23.2, 24 8 288 7 

   25 183 25.2 9 292 9.2 

Amelogenin 6-FAM  26 188 26.2 10 296 10.2 

X 83  27 192  11 300 11.2 

Y 86  28 196 28.2, 28.3 12 304 12.2 

   29 200  13 308 13.2 

D8S1179 6-FAM  29.2 202 29.3 14 312 14.2 

7 101  30 204 30.2 15 316  

8 106  31 208  16 320 16.2 

9 110  31.2 210  17 325  

10 114  32 212  17.2† 327 17.3 

11 118  32.2 214  18 329  

12 123  33 216 33.1 18.2 331  

13 127  33.2 218  19 333 19.2 

14 131  34 220 34.1 20 337  

15 135  34.2 222  21 341  

16 140  35† 224 35.2 21.2† 343  

17 144  36 228  22 345  

18 148  36.2 230  23 349 23.1 

19 152 20 37 232 37.2, 38, 
38.2, 39 

24 353  

      25 357  

      26† 361 27, 28, 29 
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Table 8. Fragment lengths of the allelic ladder Mentype® NonaplexQS extended analysed 
on an ABI PRISM® 310/3130 Genetic Analyzer (green panel) 

 
Marker/allele Size [bp]* Further 

alleles** 
Marker/allele Size [bp]* Further 

alleles** 
Marker/allele Size [bp]* Further 

alleles** 

TH01 HEX  SE33 HEX  SE33 HEX  

4 88 3 6.3 207 4.2, 5.3 25 278  

5 92  7.3 211 7 25.2 280  

6 96 6.3 8 212 8.2 26.2 284 26 

7 100 7.3 9 216 9.2 27.2‡ 288 27 

8 104 8.3 10 219  28.2 291 28, 28.3 

9 108 9.1 10.2 221  29.2 295 29 

9.3 111  11 223 11.2 30.2 299 30 

10 112  12 227 12.2 31.2 303 31 

10.3 116 11 13 231  32 305  

13 125  13.2 233 13.3 32.2 307  

13.3 128  14 235 14.2, 14.3 33 309  

   15 239  33.2 311  

D3S1358 HEX  15.2 241  34 313 34.2 

9† 145 8 16‡ 243 16.2, 16.3 35 317 35.2 

10 149  17 247 17.2, 17.3 36 321  

11 153  18 251  36.2† 323  

12 157  18.2 253 18.3 37 325 37.2 

13 161  19 255  38 329 39, 42 

14 165  19.2 257  49 372  

15 169  20 259 20.1    

16 173  20.2 261     

17 178  21 263     

18 182  21.2 265     

19 186  22.2 269 22    

20 190  23.2 272 23    

21† 194  24.2 276 24    

         

‡ For a better orientation, these alleles are heightened within the allelic ladder 
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Table 9. Fragment lengths of the allelic ladder Mentype® NonaplexQS extended  
analysed on an ABI PRISM® 310/3130 Genetic Analyzer (yellow panel) 
 

Marker/allele Size [bp]* Further alleles** Marker/allele Size [bp]* Further alleles** 

vWA NED  FGA NED  

11 108 10 14 182 15 

12 113  16 191 16.1 

13 117  17 195  

14 122  18 199 18.2 

15 126  19 203 19.2 

16 130  20 207 20.2 

17 134  21 211  

18 138  21.2† 213  

19 142  22 215 22.2 

20 146  23 219  

21 150  23.2 221 23.3 

22 154 23, 24 24 223 24.1, 24.2 

   25 227 25.2 

   26 231 26.2 

   27 235  

   28 240  

   29 244  

   30 248 30.2, 31, 31.2 

   33† 260 32.2, 33.2 

   34† 264  

   37.2† 278  

   42.2 299  

   43.2† 303  

   44.2† 307  

   45.2† 311  

   46.2† 315 47.2, 48.2, 50.2, 51.2 

* rounded to integer 

** The “off-ladder” alleles of Biotype’s DNA pool are allocated with the actual Biotype® template files for GeneMapper™ ID 
or Genotyper® software. For further alleles see amongst others http://www.cstl.nist.gov/biotech/strbase/str_fact.htm   
†  These alleles are not included in the Mentype® NonaplexQS allelic ladder. 
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5. Interpretation of results 

As mentioned above, post PCR analysis and automatic allele assignment with 
suitable analysis software ensure a precise and reliable discrimination of 
alleles. 
 
Pull-up peaks 
Pull-up peaks may occur if peak heights are outside the linear detection range 
(>3000 RFU), or if an incorrect matrix was applied. They appear at positions of 
specific peaks in other colour channels, typically with lower signal intensities. 
Peak heights should not exceed 3000 RFU in order to prevent pull-up peaks.  
 
Stutter peaks 
The occurrence of stutter peaks depends on the sequence of the repeat 
structure and the number of alleles. n-4 peaks are caused by a loss of a repeat 
unit during amplification of tetranucleotide STR motives, caused by slippage 
effects of the Taq DNA Polymerase. Interpretation of those peaks should be 
done in accordance with the Template Files of the Genotyper® and 
GeneMapper™ ID software. 
 
Template-independent addition of nucleotides 

Because of its terminal transferase activity, the Taq DNA Polymerase tends to 
add an adenosine radical at the 3’-end of the amplified DNA fragments. The 
artefact peak is one base shorter than expected (-1 peaks). All Biotype® 
primers are designed to minimise these artefacts. Artefact formation is further 
reduced by the final extension step of the PCR protocol at 68°C for 60 
minutes. Peak height of the artefact correlates with the amount of DNA. 
Laboratories should define their own limits for analysis of the peaks. 
 
Quality Sensor to check the PCR results 

Mentype® NonaplexQS contains an internal PCR check (Quality Sensor), which 
provides helpful information on the efficiency of the PCR and on presence of 
PCR inhibitors (see Fig. 6). Complete sensor failure indicates total inhibition of 
the PCR or errors in the assay. If the sensor signal is amplified in presence of 
DNA either in the negative control or in the positive control, the PCR is not 
inhibited. Samples with sufficient DNA and without inhibiting substances result 
in the DNA profile according to the kit and the sensor fragment. Reduced 
sensor peak heights in forensic samples indicate partial PCR inhibition. If only 
the Quality Sensor is amplified, the sample contains very little or degraded 
DNA. 
 
Artefacts  

Room temperature may influence the performance of PCR products on multi-
capillary instruments, so that shoulder peaks or split peaks occur. If shoulder 
or split peaks appear, we recommend injecting the sample again. 
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